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Ann Butler is a licensed artist, author,
instructor and consultant for the creative
industries. Her designs appear in multiauthored books, magazines, booklets,
manufacturer tradeshow booths and
websites.
She has been teaching workshops locally
and internationally for the past 20+ years
and currently teaches online classes at
Creative Workshops. She regularly is a
guest artist on TV and Web TV Shows.

Lisa Rojas has been a mixed media artist
and professional designer for the craft
industry over 20 years. Her work has
appeared in numerous craft magazines
and books, on websites, national
advertisements and tradeshow booths.
Lisa has also filmed multiple television
segments on Creative Living with Sheryl
Borden. She works with many
manufacturers using their products in her
work, creating projects and teaching
classes at tradeshows. Lisa is a member
of the Craft and Hobby Association.

Theresa Cifali has nearly 20 years of
experience working in the craft industry
as a professional designer. Her work
appears in books, magazines, trade show
booths and websites.
Theresa is also well versed in social
media and emerging digital platforms. Her
articles can be found on numerous
websites and in trade magazines. She
consults creative businesses on best
practices in social media, provides
management services and teaches social
strategy.
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Helen Bradley is an artist and lifestyle journalist who divides her time between the
real and digital worlds, picking the best from both. She writes about Illustrator,
Photoshop, Lightroom and digital photography for magazines and online providers
world-wide. She has written four books on photo crafts and currently produces
video training for Skillfeed.com and for her blogs at Projectwoman.com. Helen
owns more cameras than she is willing to admit to, including a point and shoot
converted to capture infra-red, a pinhole camera, a refurbished Polaroid land
camera and her Pentax d-SLR.

Jo Pearson, AKA Glitter Queen, is the Manager of Where Creativity Happens for
Michaels Stores. Starting with Michaels in 1987 was just the catalyst of her
creative career. Jo is a designer, teacher, author, and was one of the judges on
TLC’s Craft Wars with host Tori Spelling. She has hosted cruises, was teacher on
Michaels 18 wheeler craft truck, and even got to throw out first pitch at Cardinals
baseball game!
Glitter is her craft material of choice but she does admit that “If you can’t glue it,
don’t do it”. Beading is one of her favorite crafting venues and she will tell you she
has her own bead store in her design room! An avid mixed media artist, Jo loves
to “JUNK” thus her up and coming video series “Junkin with Jo”.

Going to flea markets, garage sales and antique shops is a passion and the
results are nothing less than unique to say the least. “Everyone has some
creativity in them, they just need to embrace it and not be afraid” says Jo. “Try
several mediums and find what is comfortable for you and then just GO! Don’t let
someone tell you, you can’t...there is no such word in crafting. Not everything
turns out like you want...but you tried!”

Lisa Fulmer is an artist, crafter, writer, designer, teacher, as well as a marketing
consultant. She has worked in the craft industry for many years and is an active
member of the Craft & Hobby Association. Lisa designs projects and tutorials for
craft product manufacturers and she also writes and edits regularly for
FaveCrafts.com and CraftFoxes.com. She has authored two books, Craft Your
Stash, and Stylish Craft Foam Projects – both are available online and in stores.
Signed copies are available
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Chantal Johnson has been the
recipient of God’s great love and
has been given creativity as one
of her many gifts. Her heritage is
one of Southern hospitality and
European style but her heart is
pure Texan!! Her home, as well
as her art, resounds with sentiments from a
joyful, grateful spirit to that of faith and hope
mixed with a touch of wonder. She loves all
things that can inspire others to find joy in the
everyday. Her work has been published in
Somerset Studio, Somerset Home, Sew
Somerset, Apronology, Haute Handbags, Belle
Armoire and Green Craft. She is currently on
the ICE Resin® 2016 Design Team.
Lisa Marie Jimenez is a
professional jewelry designer with
24 years of experience in the
industry. She designed her own
line of jewelry which sold to gift/
clothing boutiques for 10+ years.
Her designs have been published
in US and International bead/
jewelry magazines, along with
several front cover features. Lisa’s designs
have also graced the covers of four romance
novels. She shares her jewelry designing
techniques with others through her personal
blog and currently writes a column for an
international bead magazine.
Beth Watson is a creative design
professional, specializing in mixed
media design, three dimensional
crafts and home décor. Armed with a
formal education in
Marketing from Ringling School of Art
& Design, Beth developed her professional skills
in the restaurant industry before turning her focus
to the craft world in 1998. Beth is a member of
the CHA Designer Council and her designs have
been published in numerous craft magazines and
books. She enjoys bringing a unique twist to her
designs by using traditional materials in
unconventional ways.
6
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Lorine Mason is first and foremost a
Maker. She loves creating projects
to inspire others that are unique,
homemade and above all personal.
Sharing her creativity and the
experience of creating something
homemade is her passion. Lorine
has authored 13 books and has had her work
featured in print, online publications, on
packaging and through television programming.
She is a licensed artist and product designer.
Whether through her design work, teaching or
demonstrating, Lorine is at her best when
sharing her love of creating something
beautiful.
Martha Gomez lives with her
husband and their two daughters.
She divides her time between her
family, her work in a Public
Relations Company and her
passion: stamping and crafting.
She loves to create cards, 3D´s
and alter different projects.

Anna-Karin Evaldsson started
paper crafting in 2002. She feels
very lucky to have found the joy of
making art from paper, dies,
stamps, ink and paint. She enjoys
switching between different types
of projects: cards, tags, minibooks, art journaling, layouts, canvases and 3D/home décor. Anna-Karin loves to experiment
and try out different techniques. Every project
is a creative adventure and the possibilities are
truly endless. She is very happy to be on some
wonderful design teams and she has worked
with Eileen Hull’s dies since 2012, both on the
Sizzix US design team and for Eileen’s
Inspiration Team.
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Helen Bradley explains how a simple photo can morph into so much.
Savvy crafters know that a photograph can be a
starting point for creating all sorts of art. So,
when you're shooting images, be aware of the
possibilities of turning a photo into something
completely different. You can turn a photo of a
leaf into a Photoshop brush or a pattern or you
can capture a color scheme for a project from an
image.

In many cases, you can do this on your desktop
computer using a program like Photoshop. And
in other cases, you can use apps such as Adobe
Capture, which is part of the Adobe Creative
Cloud, to do the same thing.
On the desktop – I like the Cutout filter in
Photoshop – it converts a detailed photo into a
series of simpler solid color shapes. The effect
is more like a drawing than a photo. It's best to
use an image which has been isolated from its
background, then apply the filter and finally,
convert the resulting image into a repeating
pattern or a Photoshop brush. Use the brush in
your Photoshop projects or take your repeating
pattern swatch to a site like Spoonflower to print
it as one of a kind fabric.
To make a brush from an image, first isolate the
element you want to make into the pattern by
removing any unwanted background. Run the
Cutout filter on the photo and then select the
image and save it as a brush by choosing Edit >
Define Brush Preset. This makes a stamp style
brush you can use in any document.
To make a pattern, after running the Cutout filter,
save the image as a pattern by choosing Edit >
Define Pattern. You can then fill any image with
the pattern by choosing Edit > Fill, choose
Pattern and then the pattern you just made.
8
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For a more sophisticated pattern ensure you
have some extra space around your shape –
about as much again as the shape itself all
around it. Choose Layer > Duplicate Layer and
then Filter > Other > Offset. Set the Horizontal
and Vertical values to half the width and height
of the document and click Ok. Select all the
shapes by choosing Select > All and make your
pattern as before. This will give you a pattern
where the shapes are offset from each other.
For converting a photo into a color swatch, one
site I like is pictaculous.com. An advantage of
this site is that once you have uploaded your
photo and viewed your color scheme, you can
download it as a Photoshop ACO color swatch
file. Simply double click on the swatch file to
open it in Photoshop or any program that can
use ACO files and the colors will be immediately
available to you.

This balloon pattern started out as a photo of a
balloon and, with a few minutes of work, it could
be printed as scrapbook paper or uploaded for
one off fabric printing.

©2017 Bella Crafts™

Key Reasons You Should Leverage Social Media for Your Creative Business
Are you currently considering how to
best leverage social media as part of your
ongoing creative business' online marketing
mix? You're not alone. There is no doubt about
it, to say that social media is extremely popular
among consumers is an understatement. If you
are not using social, you can really be missing
out.
Benefits Social Media Networks Can Deliver
To Your Creative Business
If you're ready to make the initial leap into the
realm of social media, read on; understanding
some of the major benefits you can reap from
this formidable online force can help make the
initial transition as seamless as possible.
Tapping into social media delivers:
Free Advertorial Resources: Many traditional
and online marketing tactics, while seemingly
effective, still come with a hefty initial investment
price tag. Yes, coordinating your creative
business pages will take up some internal
resources, but the pages themselves are all free.
Global Reach: More importantly than simply
being free, social media networks are a proven
and effective way for businesses in any industry
to reach their prospective client demographic en
masse. When it comes to connecting with sheer
numbers of potential customers, it's tough to
beat these online resources.
Instant "Street Cred": No matter what type of
business you're operating in, it's important to
establish your organization as in "in the know"
Bella Crafts 2017 Volume 5 Issue 1

industry expert. Deciding to leverage social
media instantly showcases your business as
relevant, in touch with its modern audience and
a seasoned industry leader with something to
offer – aka instant street cred!
Personalized Connection With
Customers: Unlike other one-dimensional
promotional tactics, social media networks
deliver an opportunity for business owners to
connect with and respond to their customers.
You'll instantly gain insight on consumer
opinions as well as what you're doing right (and
not so right) to help quickly modify issues as
soon as they arise.
Competition Evaluation: Finally, deciding to
leverage social media is an outstanding (and
perfectly legit!) way to keep a steady eye on
your closest competition. It's no secret that
competitors like each other's pages – it's the
best way to gauge critical factors such as their
existing consumer offerings, how they engage
with their consumers, as well as which tactics
are (and are not) working for their organizations.
Conversely, once your company successfully
leverages its business pages, the competition
will recognize that you are an 'in-the-know'
artistic force with which to be reckoned!
Taking advantage of social media, particularly
social media networks most popular for creative
businesses (such as Instagram, Facebook and
Pinterest), can be helpful to growing and
established businesses alike. If you have not
yet dived into social, start small. Pick one
network and grow from there.

©2017 Bella Crafts™
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What is it about crafters that makes us love our
tools so much that we’re always looking for the
next best thing that has arrived on market? That
question is rhetorical because I know the answer
and I’m sure you do, too.

MISTI is short for Most Incredible Stamp Tool
Invented and is created by the company, My
Sweet Petunia. To be honest, I haven’t had it
long enough to say it’s the most incredible stamp
tool, but so far it’s pretty darn close.

We look for new tools for a couple of reasons:
They make our crafting lives easier and/or the
tool will teach us something new. As a longtime
rubber stamper, my biggest weakness is stamp
positioners. A new tool that claims to help me
stamp my images perfectly straight will send me
to the craft store every time!

The MISTI tool comes in three sizes. The MISTI
Mini has a stamping area of 4 ¾” x 6” and it’s
great crafting standard A2 size cards. The
MISTI Original which is the one I have, is
awesome for larger sized cards with a stamp
area of 6 ½” x 8 ½”. The Memory MISTI is the
largest of the three and is perfect for
scrapbooking projects. The stamping area for
this tool is 12 ¼” x 12 ¼”.

Since I began stamping 20+ years ago, I have
been on a mission to find the perfect stamp
positioner. I have bought and tried them all. My
new favorite stamp positioner is the MISTI tool.

10
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MISTI can be used with clear, foam and wood
mounted stamps. The tool has a removable
foam rubber pad that is used to accommodate
the various widths of the rubber stamps.
Now, let’s breakdown some of the fun things you
can do with this very cool tool:










Precision Stamping
Over Stamping
Stamps in the same place each time
Duplicate Card Making
Stamping Borders
Perfect Impression for larger stamps
Create Great Backgrounds
Stamp Multiple Images at once
And much more

I have listed just a few things you can do with
this tool, but there are many more. There are
some really great videos on YouTube. You can
also discover additional inspiration on the
company’s blog.
MISTI is an award-winning tool created for card
makers and paper artists alike. Give this tool a
chance and take your stamping to all new levels!

Bella Crafts 2017 Volume 5 Issue 1

©2017 Bella Crafts™

11

In depth wit
h ...
John Creighton Petersen

John Creighton Petersen is a lifelong resident of
Seattle. Although John has a degree in
photography, his vast knowledge of a wide
variety of art mediums includes painting,
calligraphy, journal and book making, collage to
beading, resin jewelry, soldering and metal work
has lead him to be dubbed a “Mixed Media
Fusion” artist by combining all of these mediums
into works of art. An in-demand working artist in
the truest sense with a passion for teaching, he’s
on the road several months every year sharing
his knowledge and techniques with others. He
12
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has served as an educator and designer for
many high-profile companies in the craft industry
including Prima Marketing, Imagine Crafts/
Tsukineko, "The ICE Prince" with ICE Resin and
Authentique Paper part of the Finnabair Creative
Team.
Get inspired by visiting John’s website at
www.artnewwave.com where you can find his
teaching schedule, tutorials and blog. Follow
him through social media channels with
artnewwave.
©2017 Bella Crafts™

A: What was your first experience with crafting?
J: I can always remember being creative,
whether with paper crafts, painting or drawing. I
can definitely say that my favorite classes in
school were always my art classes or any class
that involved some type of creativity. As a
family, we always made decorations for the
holidays, from decorating Easter eggs to making
Christmas ornaments. When I was older, I
began making journals and dabbled in making
jewelry, simply because I couldn’t find anything
at a store that I liked.
A: When did you first know that you wanted to be
an Artist or did you know?
J: I think that being an artist has always been a
part of me, simply because it’s what made me
happiest when I was younger. It wasn’t until I
was in high school and began getting more
involved in more advanced art classes and
traveling abroad as an exchange student that it
dawned upon me that being an artist could
actually be a career. This idea was solidified
when I went to college and truly found my artistic
voice.

that pop an idea into my head for a future
project.
A: Describe your studio or crafting area.
J: Despite what many people think, you don’t
need a large area to call your studio. For years I
used to create everything in the basement of our
old home – it wasn’t the ideal place, but it got the
job done. When we moved into our current
home a few years ago, the only thing on my
check list was a dedicated place for my studio.
So, we converted one of the bedrooms into a
studio space with a large closet for storing all of
my supplies.

A: What was the turning point of going from a
hobbyist to a professional?
J: I had begun creating a line of greeting cards
that featured my photography, along with
handmade journals and other books that I was
selling on the weekends at a local artists market
while still working full time at a job where I was
using my talents for creating samples, teaching
classes, etc. but felt that I wasn’t being
compensated for my talent. It was the
realization that my skills and talent were making
money for someone else instead of myself that I
decided to take the leap into being a full time
working artist.
A: We are so happy that you did!
A: Do you have a favorite craft technique?
J: Because I work in so many different mediums,
I don’t have one particular technique that is my
favorite, per se. As long as a project involves
creating some sort of cool texture and mixing
different colors, I’m happy!

I’m surrounded by many of my prototypes for
projects and classes and artwork of my friends
for inspiration.

A: What inspires you?
J: I’m inspired by so many different things – from
lyrics to a song, to the beauty found in nature,
architectural lines, works by other mixed media
artists. Often times it’s the most random things
Bella Crafts 2017 Volume 5 Issue 1
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Check out some of John’s FABULOUS
projects below and on the following page.

"Art Mechanicals Jewelry"

The majority of my supplies are organized and
stored for easy access for while I’m working and
to easily pack for teaching trips.

My studio is definitely function over fashion!
"Art Mechanicals Jewelry"

14
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“Creative Assemblage”

“Art Mechanicals Frame”

“Art Mechanicals Canvas”

“The Artist Bakers Dozen”
Mixed Media Muffin Tin
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As crafters, we all know that eye-candy gets likes
and a picture’s worth a thousand words. But it’s
those thousand words that are more likely to
drive people to click your links, check out your
site and buy your stuff.
There are so many things that a creative
solopreneur like you needs to write on any given
day to communicate with your audience interesting stories, clear tutorials, engaging
headlines, enticing descriptions, direct calls-toaction, unique observations and more. Your
ability to write well is crucial to your marketing
and/or self-promotion efforts.

Here are just a few tips for writing more effective
copy, in no particular order…and please don’t
start tweeting me if you find I’m not practicing
what I’m preaching, lol.
Make it more fun – Try peppering in a little
humor or light controversy. It’s okay to
use a little poetic license, such as staccato
sentences, text-speak or slang, to create
an effect.
Show off your personality – Your own voice
is unique and it’s YOU that will
differentiate your wares or services from
everyone else’s.

Good writing can be highly subjective, but
effective writing gets the job done. Whether
you're writing an email, a blog post or copy for a
new page on your website – the words, phrasing
and formatting that you choose are just as
important (if not more so) as proper spelling and
grammar. Your thoughtful choices should make
your readers delight in your copy from beginning
to end.
16
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Write strong headlines – Wait until after
you’ve finished writing the body of your
piece, then work out a headline that best
represents it and elicits something
emotional from your readers. Good
copywriters have a “4-U” rule: urgent,
unique, useful, ultra-specific.

©2017 Bella Crafts™

K.I.S.S. – Be clear and concise (avoid
using12 words when 3 will do) so your
reader can grasp your main points quickly.
For example - in a tutorial, don’t write
“apply the red paint with a brush to the
surface of the canvas…” when you can
just write “paint the canvas red.”

By using more descriptive words, you can
make a stronger point without exclamation.
You can avoid excessively repeating
adverbs like “very” or “so”, as well.

Format in palatable chunks – Split longer
posts or tutorials into shorter paragraphs
or steps, use subheadings, bulleted lists or
other visual cues (like little arrows) to
make it easier on the eyes.
Use an active voice – Instead of writing “This
adhesive allowed me to easily reposition
each element…” which is a passive voice,
try “With this adhesive, I could easily
reposition each element…” If you are the
subject, then you should be doing things, Writing is just like anything else – practice makes
rather than having things done to you.
perfect. The more often you write, the better
writer you’ll become. Write on!
Find the best word – Adding exclamation
points won’t always add punch (but your
reader might want to punch you in the face
if you use too many). Try substituting
“pretty!!!” with “stunning” or “captivating.”

Bella Crafts 2017 Volume 5 Issue 1
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I love dolls made of old things; love adding
unusual items to make them one of a kind. Just
walk through an antique or junk store and let
your imagination run wild. Thus, an old bobbin
becomes a whimsical doll. A little ephemera,
like old spoons, door knobs, ribbon and jewelry,
becomes that one of a kind treasure. Let’s get
started.
Materials:
 Old wooden spool (the one I used is 12
inches)
 Old door knob
 Flattened spoons, (2)
 Flat-backed rhinestone pieces for spoons
 Burlap ribbon, 1 yard
 Print tulle, 2 yards
 Tulle, gold, ½ yard for bow
 Assorted pieces of choice for top of door
knob (I used a ring type piece with a
rhinestone ball on top)
 Rhinestones, flat backed (3) for buttons
 Hanging jewelry piece as necklace ( I used
an old earring)
 Mini eyehook
 Small screws (2 for spoons)
 E-6000 glue

3. Use the small screws to attach the spoons to
the top of the spool.
4. Attach the necklace piece to the eye hook
and screw it into center hole.
5. Glue the door knob to the top of spool and
attach an embellishment on top of it.
6. Gather tulle and secure around the bottom of
spool as shown.
7. Gather burlap ribbon and secure around the
spool on top of the tulle.
8. Tie a small tulle bow around the top of the
burlap.

Tools:
 Dremel-like drill with small bit
 Needle and thread
 Anvil and hammer
 Safety glasses
Start the FUN: Always wear your safety glasses
when drilling!!!
Instructions:
1. Drill 3 small holes in the top rim of the spool,
one on each side as arms and one in center
to hang a jewelry piece.
Note: You can keep your spoons as they are or
flatten them, like mine. Always hammer on a
SOLID surface!!!
2. Flatten your spoons and drill a hole at end of
the handle. Glue flat, rhinestone pieces to
center of the spoons.
18
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Remember that my doll is just an idea to help
you get started. There are so many sizes and
shapes of spools to choose from. Your door
knob can be new too—there are some great
ones to choose from at craft stores. Just have
fun and most of all use your imagination!!
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By Lisa Rojas

A few years ago, my mom gave me a huge box of
antique lace, doilies, hand towels and hankies. I was
in heaven thinking of all the projects I could create with
these beautiful items! This no-sew project is easy to
create and would make a wonderful gift for someone
you love. This one is on its way to my mom.

Materials:
 Vintage hand towel
 Assorted lace
 Doilies, white, heart shaped, (2)
 Fabric flowers, lavender 1 ¼”, (2)
 Fabric flowers, lavender 1”, (2)
 Pearl stickers, (2)
 Beacon Adhesives Fabri-Tac
 Ink, lavender
 Cardstock, lavender, scrap piece
Tools:
 Iron
 Word stamp
 Scissors
 Display hanger

Bella Crafts 2017 Volume 5 Issue 1

Instructions:
1. Cut the hand towel to 5 ½” x 7”. Turn
the top and both sides under ¼” and
iron to create seams. Then, glue them
down.
2. Cut three pieces of lace 5 ½” long and
attach to the hand towel.
3. Adhere the heart doilies, flowers and
pearl stickers.
4. On a small scrap of lavender
cardstock, stamp the saying. Cut it out
and add it to the label on the display
hanger. Attach the hand towel to the
display hanger.

©2017 Bella Crafts™
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Shaker cards are one of
my favorite paper craft
projects to create. I
have always made them
with foam core board, so
this clear plastic photo
sleeve was a fun change
of pace. Instead of a
typical card, I made a tag
that would be perfect to
put on a keychain or
hang it in your car. How
fun is that?!

By Lisa Rojas

Materials:
 We R Memory Keepers Photo Sleeves, clear,
4” x 6”
 Chipboard frame
 Cardstock, light green
 Button
 Assorted beads and sequins
 Assorted fibers
 Zip Dry Paper Glue
 Eyelet, blue
 Photo
Tools:
 We R Memory Keepers: Photo Sleeve Fuse
Tool, Fuse Ruler, Crop-A-Dile
 Scissors
22
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Instructions:
1. Adhere the photo to the chipboard frame.
Cover the back with light green cardstock
2. Cut the photo sleeve into a tag shape.
3. Place the chipboard frame into the photo
sleeve. Also add the beads and sequins
inside.
4. Following the manufacturer’s instructions,
use the Fuse Tool and Ruler to seal the
sleeve.
5. Punch a hole in the top of the photo sleeve
and set the eyelet into the hole.
6. Add fibers through the eyelet.
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This project came about
one afternoon when I found
a few keys. I asked my
husband what the keys
were for and I received the
answer to my question with
an “I don’t know”. How
frustrating!!! I decided that
after I found where the keys
belonged, I would mark
them somehow. These little
Mod Podge molds were
perfect for the job!

By Lisa Rojas

Materials:
 Mod Podge Mod Melts, White Milk Glass
 Mod Podge Mod Molds: Flowers, Royal Icons
 Mod Podge Sheer Colors: Yellow, Purple,
Green
 Beacon Power-Tac
Tools:
 Mod Podge Melter Tool
 Paintbrush
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Instructions:
1. Following the manufacturer’s instructions, fill
the Mod Melter mold with the Melts. When
they’re dry, pop them out of the molds.
2. Use a paintbrush to apply the sheer colors to
each embellishment.
3. Once the paints are dry, glue the
embellishments to the keys.
4. Note: Make sure the embellishment does not
interfere with the notches on the key and key
ring.
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By Ann Butler

Create a one-of-a kind dry erase board in minutes
with decorative paper and a frame. Take it a step
further and print a permanent To Do List on the
paper before framing and you are set.
Materials:
 Decorative cardstock
 Frame, 8” x 10”
 Dry erase markers
 To Do List PDF, optional
Tools:
 Paper trimmer
 Computer, optional
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Instructions:
1. Remove the back from the frame.
2. Print the PDF onto the cardstock, if desired.
3. Cut the decorative cardstock to fit into the
frame and then, place inside.
4. Reassemble the frame.
Designer Tips:
 Simply use a baby wipe to clean off the
marker from the glass.
 Create your own list to print off and put into
the frame.
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I’ll admit it, I’m a typical
Nana who loves taking
photos of my
grandchildren!
Unfortunately, life gets
busy and my photos end
up stored in my
computer. So, when I
get an idea for a quick
photo album, I jump on
it. This is one of those
albums.

By Lisa Rojas

Materials:
 Kaisercraft Polaroid Chipboard Album
 Patterned papers
 Cardstock, light green, scrap piece
 3D stickers
 Assorted buttons
 Assorted ribbons
 Zip Dry Paper Glue
 Binder rings, green (2)
Tools:
 Computer
 Printer
 Exacto knife
26
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Instructions:
1. Cover the front of the album pages with
patterned papers. Cut the centers out with
an exacto knife. Add photos and cover the
backs with patterned papers
2. Decorate the pages with stickers and
buttons.
3. Create the names on a computer and print
them out on light green cardstock. Cut it out
and adhere it to the front of the album
4. Place the album pages together and secure
with binder rings.
5. Cut six pieces of assorted ribbons 7” long.
Tie the ribbons around the binder rings.
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This vintage keychain is
so easy to make. The
assembly just takes a
few minutes, even
though you will need to
leave it a while to dry
thoroughly.

By Theresa Cifali

Materials:
 Vintage typewriter keys
 Wire, 30 gauge
 Fibers
 Keychain ring
 Jump rings, 10mm (2)
 Beacon Adhesives PowerTac
Tools:
 Flat nose pliers (2)
Instructions:
1. Decide on a word and select the appropriate
typewriter keys.
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2. Glue the keys together and let dry overnight.
3. Once dry, attach a jump ring to each end of
the glued keys. One 10mm jump ring will
easily go through the 2 holes that are already
in the typewriter keys.
4. Cut a few lengths of fibers and tie to one of
the jumprings.
5. Add a keychain ring to the other jump ring.
6. Next, turn the keys over and weave some
wire through the holes between the typewriter
keys, twisting and securing them together.
Then, add some more adhesive over the
wire, for additional strength.
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By Theresa Cifali

Surprise someone this spring, with a handmade

birthday card with a gift card holder built right
in. It’s sure to brighten someone.

Materials:
 Watercolor paper
 Patterned paper
 Permanent ink pad, black
 Dye ink pad, light purple
 Library pocket
 Colored pencils
 Foam tape or dots
 Double-sided tape
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Tools:
 Rubber stamps: butterfly, Happy Birthday
sentiment
 Paper trimmer
 Scissors
 Heat gun
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Instructions:
1. Cut a piece of watercolor paper 5 ½” x 8
½” and then, fold in half to make the card
base.
2. Smoosh the purple ink pad over the card
front, making sure to get the edges.
3. Cut the patterned paper 3 ¾” x 5”. Tape
to the card front.
4. Stamp the butterfly and Happy Birthday
onto watercolor paper in permanent ink.
Heat set.
5. Color and cut out the butterfly.
6. Tear around the Happy Birthday and
smoosh the purple pad over the torn
edges.
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7. Attach both pieces to the card front with
foam tape.
8. Next, stamp the sentiment to the center of
the library pocket. Stamp the butterfly
wings partially around the edges. Heat
set.
9. Smoosh the purple ink pad around the
outside edges of the pocket. Then, add
some color to the butterfly wings with the
pencils.
10. Tape the pocket to the inside of the card.

©2017 Bella Crafts™
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Tags are so quick and easy
to make and they can be
used for just about
anything. I like to keep a
good supply of tags on
hand as they are a perfect
addition to a gift, gift bag or
to tuck into a card.

By Ann Butler

Materials:
 Ann Butler’s Faux Quilting Stamps, 1”
Triangles, assorted
 Ann Butler’s Crafter’s Ink by Clearsnap,
Ocean Breeze
 Fine tip marker, black
 Charm
 Tag, 1 ½” x 4 ½”, white
 Tag, 1 ¾” x 4 ¾”, blue
 Fibers, assorted
 Glue stick

Instructions:
1. Stamp 6 triangles onto the white tag, as
shown in the photo. Heat set.
2. Draw dash lines around each triangle.
3. Glue the white tag onto the center of the blue
tag.
4. Attach the charm to the tag with a piece of
fiber.
5. Add more fibers to the top of the tag.

Tools:
 Scissors
 Heat gun
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I love taking pictures with
my camera, but being a
designer, I hated the
plain black camera strap.
I need color and pretty
patterns! I thought about
covering my strap with
rhinestones, but I didn’t
think they would hold up
to wear and tear, so I
decided to create this no
-sew strap cover. I even
made a few different
ones, so if I get bored I
can change them out.

By Lisa Rojas

Materials:
 Fabric
 Beacon Fabri-Tac
Tools:
 Iron
 Scissors
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Instructions:
1. Cut the fabric 5” x 21”. Iron to remove any
wrinkles.
2. Fold the sides of the fabric under ¼”. Iron
each side to create a seam.
3. Glue down each edge.
4. With the wrong sides together, fold the fabric
in half lengthwise and glue edges together.
5. Once dry, slip the camera strap inside the
fabric tube.

©2017 Bella Crafts™

31

By Lisa Rojas

Who wouldn’t want to share a pot of tea on
this cute floral trivet? By adding a small tea
pot and cup in a decorated bag, this trivet
would be a perfect hostess gift.

Materials:
 Trivet, wood
 Washi tape
 Plaid Mod Podge, Gloss
Tools:
 Paintbrush, ½”
 Scissors
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Instructions:
1. Wipe off the trivet with a clean paper towel to
remove dust and dirt.
2. Adhere the washi tape to each slat in the
trivet.
3. Cut off excess washi tape.
4. Apply two coats of Mod Podge to the trivet.
Let dry between each coat.
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By Lisa Rojas

A birthday party is never complete without some super fun goody bags!
These little bags can be filled with all kinds of cool stuff, making them
great for kid parties and adult parties alike.
Materials:
 We R Memory Keepers Photo Sleeve, 4” x 4”
 We R Memory Keepers FUSEables Fringe
Strip, kraft
 Patterned paper, 4” x 4”
 Assorted stickers
 Candy
Tools:
 We R Memory Keepers Photo Sleeve Fuse
Tool
 Scissors
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Instructions:
1. Cut the patterned paper 4” x 4”. Slip the
paper into the photo sleeve.
2. Add the candy into the photo sleeve
3. Cut the fringe strip 4” long.
4. Using the Fuse tool, attach the fringe strip to
the photo sleeve.
5. Adhere the stickers to the front of the photo
sleeve.
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By Lisa Rojas

Nothing says “Welcome Spring” better than a box full of
flowers, even if they’re paper! This pretty box would make a
fabulous table decoration for a springtime party or even an
outdoor wedding. Using pre-colored stickers instead of
stamped flowers makes this project quick and easy too!
Materials:
 Cardstock: light green, plum
 Patterned paper, 2 ¼” x 2 ¼”, (4)
 Clearsnap Colorbox Ink, Frosted Plum
 Wire, green, 24 gauge
 Zip Dry Paper Glue
 Floral stickers
 Floral chipboard pieces
 Shredded paper, iridescent
Tools:
 Spellbinders Die Cutting Machine
 Spellbinders Scalloped Pop Up Box Die
Cut
 Paper trimmer
 Wire cutters
 Glue gun
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Instructions:
1. Following the instructions for the die
cutting machine, cut out the pop up box in
light green cardstock. In plum cardstock,
die cut eight of the small lace, one large
lace and three strips for the inside of the
box.
2. Assemble the box following the
manufacturer’s instructions. Glue together
with Zip Dry.
3. Cut four pieces of the patterned paper 2
¼” x 2 ¼”. Ink the edges. Adhere the
patterned papers and the lace to the box.
See photo for placement.
4. Attach the three strips inside the box.
5. Cut seven pieces of wire 3 ½” long. Add
the wire to the backs of the flowers with
hot glue. Add the iridescent paper and the
flowers to the inside of the box.
6. Glue the chipboard pieces to the front of
the box.
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Partners with AdoptAClassroom.org to Inspire Creativity Among Students in Low-Income Areas

On April 2, 2017 the crafters of Atlanta-based
Craft Box Girls will host its second annual
National DIY Day to celebrate creativity and the
art of making at a time when screen time among
children is at an all-time high.
“It remains important, even critical, that kids are
empowered to explore their imagination through
the power of play and crafting is one of the best
play-time activities in the books,” said Lynn Lilly,
chief executive officer of Craft Box Girls. “We
launched National DIY Day last year to bring
broader recognition to the art of creativity
through crafting and this year, we’re excited to
expand our impact even further.”
This year, Lilly expects to have 15 million people
take part in National DIY Day, a growth rate of
650% over last year and she plans to do it by
leveraging digital media, partnership with brands
like Plaid Crafts, Cricut and Bella Crafts
Magazine, as well as a national television
campaign and partnering with
AdoptAClassroom.org, its 2017 cause partner.
Lilly and her team in Atlanta will lead the global
digital event and creative workshops from
Binders Art Supplies & Frames at the popular
Ponce City Market. Additionally, 25 crafting
ambassadors were selected from all parts of the
United States to help make this a fun-filled day
and shine a light on the art of creativity. They
will use their digital channels to “live craft” on
National DIY Day in events that will run from 10
a.m. - 7 p.m. on April 2. The lineup of live
stream crafting and DIY events and Atlanta
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based workshops is available at
NationalDIYDay.com.
“Our National DIY Day team will teach kids of all
ages how to express their creativity through
crafting and DIY with fun and engaging activities
planned throughout the day. All of which will be
live streamed from multiple digital platforms
including Facebook Live, Instagram Stories, and
blogs,” Lilly said. “Many of the ambassadors as
well as myself are also booked on local
television across the country to teach viewers
simple crafting projects to bring more awareness
to the art of making and creativity.”
New this year is Craft Box Girls’ cause partner
for National DIY Day 2017,
AdoptAClassroom.org.
“National DIY DAY and Craft Box Girls are proud
to support AdoptAClassroom.org and their
mission to give teachers a hand by providing
much-needed classroom materials so that their
students can learn and succeed. Craft Box Girls
is committed to supporting classrooms and
providing tools for students and teachers to
enhance the creative learning experience,” Lilly
said.
Leading up to National DIY Day, from March 1 to
April 2, Craft Box Girls will host a “Text to Give”
campaign to fundraise for AdoptAClassroom.org,
which will be promoted through its social media
channels, ambassador network, television
segments and the AdoptAClassroom.org social
media networks.
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Craft Box Girls has also teamed up with Plaid
Crafts to give 15 lucky crafters a “Plaid Party”
which includes a craft party kit to host their own
National DIY Day event at home. Participants
may enter the contest on NationalDIYDay.com.
Additionally, supporters are encouraged to shop
the newly-launched merchandise store on
NationalDIYDay.com. T-shirts, designed by three
artists who won a national design competition, as
well as tote bags are for sale.
National DIY DAY was established annually on
the date of April 2. It is a movement to celebrate
creativity and the art of making. The Craft Box
Girls team launched the very first National DIY
DAY on April 2, 2016, to bring people together for
a day of creativity and making.
Photos from the 2016 event:

National DIY DAY and Craft Box Girls are proud
to support AdoptAClassroom.org and their
mission to give teachers a hand by providing
much-needed classroom materials so that their
students can learn and succeed. Craft Box Girls
is committed to supporting classrooms and
providing tools for students and teachers to
enhance the creative learning experience
Support AdoptAClassroom.org by Texting a
Donation Today! Text the word "Give" to (678)

582-8594 and you will be prompted through a
secure system to make a donation of your
choice!
Lynn Lilly and members of the National DIY DAY
ambassador team are available for television,
radio and digital interviews and demonstrations.
Bella Crafts 2017 Volume 5 Issue 1
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By Chan Vu for Craft Box Girls

I love the flexibility of dried moss. The evergreen aspect makes moss one of the best
craft supplies for anything fun and whimsical. I've used moss on many DIY projects
and the outcomes are always satisfying. With National DIY Day just around the corner
this spring, I wanted to add this to our collection of fun spring projects.
I'm using dried moss to create a garden moss sign. I think it adds a fresh look to the
garden during the transition from winter to spring. Let's start celebrating!
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Materials:
 Metal letters
 Arrow
 Spray paint, white
 Moss, dried roll
 Wood board
 Nails

4. Lay the letters and arrow out onto the board
as desired. Then, attach the letters and
arrow on the board using the hammer and
nails.
5. Hang the board at the entrance of a garden
gate.

Tools:
 Glue gun
 Hammer
 Scissors
Instructions:
1. Spray paint the metal letters and arrow.
2. Trim the moss to fit the dimensions of the
board.
3. Glue the moss to the board. Be sure to glue
around the edges and in the middle of the
board.
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By Carl Becker for ETI

Materials:
®
 EnviroTex Lite 8 oz Kit
ArtMinds Wood Coaster Set
 Craft Smart Premium Satin Acrylic Paint,
Black
Aleene’s Original Tacky Glue
 Adhesive Felt Sheets, Black
Photos
Tools:
 Measure / mixing cups
 Stir sticks
 Paintbrush
 Disposable foam brush
 Scissors
 Wax or newspaper
 Disposable latex gloves
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Instructions:
1. Paint the coasters on all sides. Let dry.
2. Cut photos to fit the coasters.
3. Brush a thin layer of glue on the top of each
coaster and then, align and attach the
photos. Use your fingers to press and
smooth the photos as required. Ensure no
air bubbles are trapped between the paper
and project surface. If necessary, a brayer
or a hard, round, smooth bottle works well to
roll out trapped air.
4. Apply a thin layer of glue over the top of
each photo, ensuring that the edges of the
photos are covered. This seals the paper so
that the EnviroTex isn’t absorbed into the
paper, creating wet spots along the edges.
Let dry overnight.
5. Protect your work surface with wax or
newspaper. Then, elevate the coasters with
disposable plastic cups or similar item. This
will allow the EnviroTex to drip over the edge
of the project surface.
6. Measure and mix 4 oz. of EnviroTex Lite
according to the product instructions.
7. Pour EnviroTex Lite onto the surface of each
coaster, as per the product instructions.
8. If necessary, gently help spread the
EnviroTex Lite with a foam brush to help
product flow over the edges of the coasters.
9. 15 minutes after pouring, remove any
bubbles from the coating, as per the
EnviroTex Lite instructions. Allow the pieces
to completely cure (72 hours) and then, sand
the drips on underside, if necessary. Wear
protective eyewear and dust mask while
sanding.
10. Cut the felt to fit the bottom of each coaster
and apply.
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43

44

Bella Crafts 2017 Volume 5 Issue 1

©2017 Bella Crafts™

By Anna-Karin

Evaldsson

This pretty Felt Flower Caddy Bag doubles as a home décor
piece and storage unit. It can be used for a small gift or to store,
for example, pens, buttons, or other craft supplies. The painted,
stenciled and stamped background can be customized to fit the
recipient’s interests and décor. Handmade flowers are fun to
make and using a die to cut them makes the process very easy
and quick.
Materials:
 Sizzix Little Sizzles Mat Board, White, 6” x
13”
 Ranger Watercolor Paper
 Ranger Dina Wakley Media Heavy Body
Acrylic Paint: Sky, Elephant, White
 Ranger Dina Wakley Media, White Gesso
 Ranger Distress Ink: Cracked Pistachio,
Evergreen Bough
 Ranger Archival Ink, Jet Black
 Tim Holtz idea-ology Small Talk Stickers
 Ranger Wonder Tape
 28 Lilac Lane Birds of a Feather
Embellishment Bottle Kit
 Felt
 Embroidery floss
Tools:
 Sizzix Eileen Hull Caddy Bag ScoreBoards
XL Die #657123, Heart & Soul Flower Bigz
Die #661108, Spring Leaves Bigz Die
#661111
 Sizzix Big Shot
 Sizzix Cutting Pads
 Sizzix Extended Cutting Pads
 Stamper’s Anonymous Tim Holtz Stencils:
Industrial, Mini Stencil Set 5
 Spellbinders Tammy Tutterow, Dear Ruby
Stamp
 Palette knife
 Non-stick craft sheet
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Instructions:
1. Die cut the Caddy Bag from the matboard.
2. Coat the matboard with a layer of gesso, to
prepare it for painting. Let dry.
3. Smear acrylic paints on the mat board with a
palette knife.
4. Before the paint has dried completely, place
a stencil on top and rub off paint through the
stencil with a slightly moist cloth. Repeat
with a second stencil.
5. Randomly stamp the surface with a script
stamp.
6. Assemble the Caddy Bag with the Wonder
Tape. The Sizzix ScoreBoards dies both
cuts and scores the material, which makes
assembly very easy.
7. Die cut two big flowers and one smaller one
from purple felt.
8. Layer the flowers together and stitch a
button to the center.
9. Smear Cracked Pistachio and Evergreen ink
on a craft sheet and mist with water. Press
a piece of watercolor paper into the ink.
10. When dry, die cut leaves from the paper.
11. Glue the flower and leaves to the bag and
embellish with buttons, beads and sentiment
stickers.
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By Eileen Hull for Eileen Hull Design

Add an elegant and personal touch to the next gift card
you give. The handmade box is a present in itself! The
iridescent paint accentuates the embossing and the
blues and greens are perfect for any occasion.

Materials:
 Ann Butler’s Iridescents by Earth Safe
Finishes: Emerald, Limelight
 Sizzix mat board pack, white
 ThermOWeb Super Tape, ¼”
 Coffee filters
 Crinoline
 Wire, gold, 24 gauge
 Jump rings
 Brad
 Embroidery floss, white
 Cap finding
Tools:
 Sizzix Big Shot
 Eileen Hull Twist & Style Tool by Sizzix
 Eileen Hull Dies by Sizzix: Box with
Scalloped Flap, Romance Flower, Spring
Leaves
 Eileen Hull Texture Sheet by Sizzix, Eyelet
Lace
 Stapler
Instructions:
1. Die cut the box from mat board. Place it in
the Eyelet Lace folder and emboss it.
2. Die cut two smaller Romance flowers from
coffee filters and thread them onto a brad.
Take each petal and squish into the center.
Then fluff out when all are “squished”.
3. Die cut leaves from crinoline and paint
lightly with Emerald.
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4. Paint the outside of the box randomly with
Emerald and Limelight, blending the colors
together.
5. Place tape on the tabs of box and adhere
together. Attach flower and leaves to the
point of the box flap.
6. Cut two lengths of wire about 1 1/2 yards
long and fold each one in half. One at a
time, twist each with the Twist & Style tool,
following the package directions. With one,
form the word “bloom” to fit across the flap
of the box. Staple it to the box. Fold the
other into thirds and makes loops on both
ends.
7. Punch small holes at top of box on each
side. Insert jump rings in holes. Attach the
looped wire ends into jump rings to create a
handle.
8. To make the tassel, cut two pieces of
cording 1 yard and 5”. Wrap 1 yard of
cording around four fingers of your
dominant hand in loops. When you have
enough for a tassel, slide it off your hand
and make a knot over one section of loop
using 5” piece (this is the top). Thread
strings through the cap. Cut the cord at the
bottom of the tassel and trim, so all strands
are even. Tie onto the jump ring on he side
of the box.
9. Add a gift card and a note!
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By Carole Monahan for Makin’s Clay®

Soft, subtle colors, combined with an interesting
textured pattern, make this dreamy pendant made with
Makin’s Clay® a perfect accent for your spring
wardrobe.
Materials:
 Makin’s Clay®, white, 60g
 Pan Pastels
 Grommets, brass (2)
 Swarovski crystal (1)
 Leather cord
 Findings, brass for necklace
 Beacon Adhesives Tacky Glue
 PYMII
Tools:
 Makin's Professional® Ultimate Clay
Machine®
 Makin's® Texture Sheet Set H - Abstract A
 Makin’s® Cutting Mat
 Makin's® Professional Clay Tools®
 Altered Art Source unmounted rubber
template
 Hole punch
 Jewelry pliers
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Instructions:
1. Place the clay in the machine and roll on
setting #1. Repeat on setting #2.
2. Place the texture sheet over the rolled clay
and gently press to add texture.
3. Place the rubber template over the textured
clay and press the edges only to impress the
shape, but not the texture.
4. Remove the template.
5. Color with Pan Pastels, layering and blending
colors.
6. Mount crystal accent with Tacky Glue. Let
dry.
7. Use the cutting wheel from to remove excess
clay from around the shape.
8. Let the pastel colored clay dry for 24 hours.
9. Seal with PYMII. Let dry.
10. Punch holes in the two upper corners.
11. Add grommets, adding a small amount of
glue for extra strength.
12. Add the leather cording.
13. Add the closure.
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By Lisa Marie Jimenez

Spring is here and gardens are starting to bloom. Garden fairies are
dancing from petal to petal. Their wings may still be dusted with
snow and have a beautiful aurora borealis effect when the sunlight
glistens on them. This Mystical Garden Fairy necklace has beautiful,
glittering purple and blue tones that mimic that of a fairy with snow
dusted wings.

Materials:
 Glass teardrop pendant, 38x24mm
 Colored wing connectors, 50mm (2)
 Fairy charm, Antique Gold
 Oval link chain, Antique Gold, 14”
 Etched round jump ring, Antique Gold
 Round jump ring, Antique Gold, 6mm (6)
 Lobster clasp, Antique Gold
 Fold over filigree bail and Micro brass
screw/nut or ice pick bail, Antique Gold
Tools:
 Flat nose pliers (2 sets)
 Round nose pliers
 Chain nose pliers
 Cutters
 Small metal file
 Glue
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Instructions:
1. Remove the top ring from the fairy charm
and then, glue the fairy to the front of the
glass pendant. Set aside to dry.
2. Add the ice pick bail to the top of the
glass pendant. Or, if using a fold over
bail and micro screw, fold the filigree bail
in half and then secure to the glass
pendant using the micro screw and nut
set. Cut off any extra metal left on the
back of the screw. File away any rough
edges.
3. Open the etched jump ring and then, add
it to the top of the bail. Leave the jump
ring open for next step.
4. Open a 6mm jump ring and then, add it
to the bottom hole of the wing connector.
Close the jump ring. Repeat this step for
the opposite wing. Next, add the jump
rings to the etched jump ring from
previous step. Use the photo as a guide.
Close the etched jump ring.
5. Cut the chain into two 7 inch pieces.
Open a 6mm jump ring and then,
connect the end link of the chain to the
top hole on the angel connector. Repeat
for opposite wing.
6. Open a jump ring and then, connect the
lobster clasp to one end of the chain.
Add the last jump ring to the opposite
end of the chain.
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By Chantal Johnson

Usually, the Winter Blues set in a little after the holidays are over. It’s not a surprise
when, with all that holiday cheer that filled our home during the season and is all
packed up and put away, our house can feel a little empty; a little less colorful. This
project is designed to chase those blues away with a simple whitewash technique
revealing the intricacies of the wood grain that will turn these winter blues into a wall
hanging of beauty. You will find that you will want to wash everything but the laundry.
Materials:
 Wood pallet plaque or board
 Small wood heart
 Wood tag
 Hooks (3)
 Upholstery tacks (5)
 Metal word
 Metal embellishments of choice
 Seam binding or ribbon, white
 Small bottles (2)
 Jute covered wire (available in the floral
section of you craft store)
 Small bunch of dried flowers
 Eyelet
 Scrapbooking paper, 1-2 sheets
 Chalk Acrylic Paint: Buttercream, Blue Jay
 Eco Green Acrylic Paint, Lake
 Colorbox® inkpad, Chestnut Roan
 Mod Podge® or Ranger Collage Glue™
 Glossy Accents™

and more of a water consistency. Paint the
pallet with a generous coating of the white
wash mixture. Then, use a new brush to
brush the excess paint off of the wood pallet.
You can also use the paper towels to wipe
the excess. Let dry.
3. Here’s where you can build layers, let it dry
and then go back and repeat step 2 until
desired look is achieved. You should see the
wood grain after each layer of paint.
4. Place the ivory seam binding/ribbon into the
white wash paint mixture, scrunch it up and
wring the excess out. Let dry or dry with a
heat gun. Now your ribbon coordinates with
your wood.
5. Ink the edges with Chestnut Roan to define
them.
6. Once the paint is dry, seal with Mod Podge or
a sealer of choice.
7. Hammer in small upholstery tacks. Then, add
hooks and metal word.
Tools:
8. With Mod Podge or Collage Glue, adhere
 Paintbrushes, medium size (3)
scrapbooking paper to front of the heart and
 Paint palette
tag. Ink edges as in step 4. Set an eyelet in
 Disposable bowl or cup
the tag with the Crop-o-dile. Add the ribbon
 Paper towels
to the tag.
 Sanding paper, if needed
9. Create a double bow and tie it through the
 Crop-o-dile® or Eyelet Setter
hook on the heart. If your heart doesn’t have
 Round nose pliers
a hook, use an adhesive to adhere the bow.
 Small hammer
10. Cut an 18” length of jute covered wire and
 Wire cutters
wire wrap the top of the bottle creating a
hanger.
Instructions:
11. Using a strong adhesive such as Glossy
1. Sand the wood, if necessary. Paint a thin
Accents, adhere the heart and the metal
coat of Blue Jay on all sides and edges of the
embellishment to the wood pallet. Set aside
wood pallet, tag and heart. No need to worry
to dry.
about this coat, just a nice covering. Let dry. 12. Add fresh or dried flowers to your bottles and
2. In a disposable cup/bowl, mix 30% of Lake
hang it up in your home…the winter blues
with 70% water. This needs to be very thin
look great!!
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By Helen Bradley

Sewing small pieces of shiny, fragile fabric sounds like it
should be a nightmare. It is! But this embroidery only looks like
it's made by sewing on small pieces of fabric. In fact, there's a
secret to sewing this that makes it simple to make and not
fiddly at all. Interested? Read on...
Materials:
 Embroidery hoop (5" - 6")
 DMC® 6 strand thread to match pink/
purple fabric
 Pink/purple satin or similar fabric, 9" x 9"
 Gold satin or similar fabric, 9" x 9"
 Ribbon for hanging, 10"
Tools:
 Sharp fine point scissors
 Embroidery and sewing needles
 Disappearing marking pen (optional)

cutting. Do not cut through the pink
fabric!
5. Finish the embroidery by gathering up the
excess fabric at the back of the hoop. Cut
a circle of stiff fabric slightly smaller than
the hoop and hem stitch the felt over the
gathered satin.
6. Thread the ribbon through the top of the
hoop and tie the ends in a knot for
hanging. (Optional)

Instructions:
1. Iron both fabrics. Assemble both fabric
pieces face up with the gold on top of the
pink. Place both layers in the embroidery
hoop with the gold fabric right side facing
up.
2. Sketch the outline of the project on your
fabric using disappearing pen (Optional)
on your fabric. Tack over the pen lines to
mark out where you will sew. You may
download a free for personal use copy of
the diamond design from app.box.com/v/
diamondpattern,
3. Using the embroidery thread, sew your
diamond and narrow triangle shapes
around it. Make sure to sew through both
pieces of fabric.
4. Remove the fabric from the frame and cut
away the gold fabric leaving only a small
piece of the fabric under the stitches.
Once you have cut away the larger pieces
of fabric you may find it easier to return
the embroidery to the frame to finish
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By Lisa Rojas

With a piece of muslin, some rubber stamps and fabric
inks, you can create a beautiful project that will
definitely bring a touch of spring into your home décor!
Materials:
 ColorBox Crafter’s Ink, Night
 Ann Butler Designs Crafter’s Re-inkers by
Clearsnap: Berry, Ocean Breeze, Lilac,
Sunshine, Evergreen
 Flower bouquet
 Beacon Adhesives Fabri-Tac
 Rice
 Stuffing
 Raffia
 Ribbon, green checkered

7. Fill the bottom of the bag with
approximately two cups of rice to help the
bag stand up. Fill the remainder of the
bag with stuffing.
8. Place the flower bouquet in the bag. Tie
a raffia bow around the flowers and the
bag to close it. Add a small ribbon bow to
the front of the bag.

Tools:
 Rubber stamps
 Paintbrush
 Iron
 Heat tool
 Scissors
Instructions:
1. Cut the muslin 7 ½” x 23 ½”. Then, fold it
in half.
2. Turn the top and sides under ¼” and iron
them down. Glue the seams together.
3. With the right sides together, glue at the
edges. Turn the fabric inside out. You
now have your bag and you’re ready to
paint it.
4. Place a piece of cardboard inside the bag
before you begin painting. This will keep
the ink and paints from spreading to the
back of the bag.
5. Stamp the flowers and butterflies on the
front of the bag in black. Heat set.
6. Paint the images on the bag using reinkers and paintbrush. Heat set.
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By Beth Pingry for Scrapbook Adhesives by 3L®

Use coordinating paper and adhesives to
create a sweet card with an unexpected
element! Simply use clear adhesive along
the edge of a pre-printed sign and add clear
micro beads. Wrap with twine, pop on a
button and add a few layers with photo
corners. It’s done and ready to wow the
lucky recipient!
Materials:
 Scrapbook Adhesives by 3L® E-Z Dots®
Permanent Refillable Dispenser
 Scrapbook Adhesives by 3L® Creative
Photo Corners Kraft
 Scrapbook Adhesives by 3L® Creative
Photo Corners Ivory
 Scrapbook Adhesives by 3L® Dodz
Adhesive Dots Medium
 Donna Salazar with Scrapbook
Adhesives by 3L® Girlie Grunge Twine
 BoBunny Secret Garden Papers: Lovely,
Arbor
 Micro beads, clear
 Button
 Cardstock: kraft, purple
Tools:
 Scissors
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Instructions:
1. Trim the pre-printed sign from the sheet.
Tear the bottom edge.
2. Apply E-Z Dots along both sides of the
sign.
3. Pour clear micro beads onto the E-Z
Dots and then, shake off the excess.
4. Wrap Girlie Grunge Twine around the top
of the card 3 times. Tie on the back side.
5. Thread Girlie Grunge Twine into the
button. Tie a bow.
6. Attach the button with Dodz.
7. Trim the patterned papers and cardstock,
adhere with E-Z Dots and Creative Photo
Corners, alternating the colors of the
corners with each layer.
8. Create a card base from kraft paper and
then, attach the layers to the card front.
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By Amanda Vasquez for Xyron

Jazz up your office with a pretty desk
organizer in colors you love!
Materials:
 Fabric
 Cardstock
 Washi tape
 Ribbon
 Empty cereal box
 Cardboard tubes
 Bottle caps, (2)
 Flower embellishments, buttons, etc.
Tools:
 Xyron® Creative Station™ with
Permanent Adhesive Cartridge
 Xyron® 1.5” Sticker Maker
 Scissors
 Glue gun

5. Add fabric/cardstock to the cardboard
tubes. Place a bottle cap on one end of
each tube. This will be the bottom. Add
ribbon to the edges.
6. Embellish with flowers, buttons and so
on.
7. Wrap washi tape around a pen with a
flower at the top. Place in a cardboard
tube holders.
8. Variation: Turn it into a magnet that
hangs on a file cabinet. In step 1, cut the
back off and send that separately
through the Creative Station using a
magnet/laminate cartridge. Then, follow
instructions as shown.

Instructions:
1. Cut the flaps off of the cereal box and a
small rectangle section from the topfront. Make an angled cut on both sides
of the box. Cut the cardboard tubes to
size.
2. Decide which cardstock and fabric
pieces will go on both the inside and
outside of the box. Cut accordingly.
3. Place the fabric and cardstock pieces
through the Creative Station with the
permanent adhesive cartridge. Peel off
the pieces one at a time, and stick them
to the box.
4. Cut strips of ribbon to place over where
each place the cardstock and fabric
pieces meet. Place them inside the
Sticker Maker. Rub, peel and stick into
place.
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By Martha Lucia Gomez

Crafts and organization need to run hand in hand in order to know
what you have and what you "need". These tags, created with a
watercolor technique, allows me to label all my scrap bins with
something beautiful and different, while keeping me organized. You
can use different stamps or colors for each bin but if you are like me,
you'll prefer all the tags with similar designs and a few different
touches that only the watercolor can bring.
Materials:
 Cardstock: Wisteria Wonder 4 1/4"x 11",
Certainly Celery 4 1/4"x 5 1/2"
 Watercolor paper 9" x 7 1/2"
 Classic Stampin Pad™: Perfect Plum,
Soft Sky, Certainly Celery, Marina Mist
 Stampin Write Marker's™: Perfect Plum,
Marina Mist, Certainly Celery, Soft Sky
 Stampin Acrylic Block
 Glimmer paper, Blue
 Stampin Dimensionals®
 Snail adhesive
 Small pearls
 Bakers Twine, Metallic
Tools:
 Peek a Boo Designs Stamp Set,
Humming Blossom
 Stampin Up™ Butterfly Punch, small
 Stampin Up™ Deco Frames Thinlits,
Labels
 Little B™ Numbers Die Cuts
 Big Shot
 Piercing tool
Instructions:
1. Cut the cardstock in two equal pieces of
4 1/4" x 5 1/2".
2. Cut the big Deco Frame with the two
pieces of Wisteria Wonder and the
Certainly Celery cardstock.
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3. Cut 3 pieces of watercolor paper using
the next smallest size of the frame.
4. Ink the acrylic block with all four colors of
Classic Stampin Pad ink and then, spray
with water.
5. Lay the watercolor paper over the
sprayed acrylic block, press down gently
and remove the paper. Let it dry.
6. Repeat the process with the other two
pieces of watercolor paper.
7. Place the stamp on the acrylic block and
ink it with the Stampin Write Marker's.
8. Spray the stamp with water and stamp it
over the inked watercolor paper.
9. Paste the stamped watercolor paper over
the color base.
10. Decorate the borders with the piercing
tool.
11. Cut out the numbers in blue glimmer
paper and paste onto your tags.
12. On the back of your tags, paste a white
piece of paper with the info about the
content of your bin or box.
13. Finalize the decoration by adding the
punched butterfly and pearls.
14. Tie your tag to your bin or box.
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By Sherrie Ragsdale for Plaid

Materials:
 Folkart® Multi-Surface Paints: Medium
Blue, Lime Yellow, Ocean Blue, Light
Blue, Violet Pansy, Wicker White
 12” x 12” Shadow box with soft fabric
backing
 Rubbing Alcohol
 1/2" yard of white duck cloth fabric
 Fabric, white
Tools:
 Folkart® Stencils, Flowers
 Folkart® Tools: Detail Painters, Soft Grip
Wash Brush Set, 5/8" Round Stencil
Brush
 Bowl of water
 Scissors
Instructions:
1. Cut a piece of the duck cloth fabric to 12
1/2" x 12 1/2". Soak the piece in water
until it is saturated. Squeeze all the
excess water out of the fabric and lay flat.
2. Use the stencil brush to blend in all the
listed colors except for the Wicker White.
You may want to add some water to the
paint to make blending easier. Let dry.
Glue the fabric and tuck the edges under
the edge of the back of the shadow box.
If you cannot tuck it under, cut the fabric
to fit and then, glue it to the back of the
shadow box.
3. Stencil the flowers with stem in Wicker
White. You will have to cut the stencil
edges to make fit inside the shadow box.
Let dry.
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4. On a portion of the white fabric, paint
Violet Pansy on a large enough area to
stencil each flower in Wicker White. On
another portion of the white fabric, stencil
4 of the smallest flower in Violet Pansy.
You should have a total of eight flowers.
Cut out each flower. On the rest of the
fabric paint Lime Yellow on a large
enough area to stencil all the leaves in
Wicker White. Allow those to dry and
then, cut them out.
5. Paint the centers of the Violet Pansy
flowers with Medium Blue. Once dry,
glue a Wicker White flower to its
matching flower on the fabric. Then glue
the Violet Pansy flower on top of each of
those. Make sure you can see the set of
flowers underneath.
6. Glue the leaves on top of the matching
leaves on the painted fabric.
7. Clean the inside of the glass with rubbing
alcohol. Using the detail painters, paint
the vine on the inside of the glass in
Wicker White. You may need to cut the
fabric to making stenciling easier.
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By Beth Watson

I love spending time outdoors on my patio when the weather is
nice, but I definitely do not have a green thumb. So, I create
ways to decorate my courtyard that don’t include plants. The
inspiration for my project came from my never-ending supply of
small, wooden embellishments that I have hoarded collected
over the years and my love of crafting from my stash!
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Materials:
 Foam core board, black
 Wooden candlestick, 8”
 Wooden ball knob, 2”
 Wooden wheel, 2” diameter
 Wooden finial, decorative
 Wooden embellishments, assorted
 Plain paper
 Craft glue
 Design Master Colortool Spray Paint: Flat
Black, Metallic Taupe, Copper Fusion,
Antique Gold
 Newspaper
 Wire, black 24 gauge
Tools:
 Butterfly wing pattern
 Scissors
 Craft knife
 Self-healing mat
 Paper piercer (or awl)
 Wire cutters
 Tree trimming shears
 Sanding block
 Pencil
Instructions:
1. Download the butterfly wing pattern HERE,
print on plain paper, cut out, trace on black
foam core and then, cut it out with a craft
knife on a self-healing mat. NOTE: When
cutting foam core board, make sure that
your craft knife is sharp to obtain a clean cut.
2. To create the butterfly body, glue the
following wooden elements together in this
order: attach the finial to the top of the
candlestick, the wheel to the bottom of the
candlestick and the ball knob to the wheel.
Let dry.
3. Dry fit assorted wooden embellishments on
top of the butterfly wing paper pattern until
you are pleased with the composition.
4. Transfer those embellishments to foam core
butterfly wings and glue down each element.
Start with eleven mini clothespins on each
side, add eight wooden buttons just above
and then, the skewers. Trim excess length
from the skewers with scissors prior to
securing them with glue.
5. Starting at the center, adhere 24 mini
wooden pegs to each half of the butterfly
wings and then, place the wooden wheels
inside the curve of the pegs. Fill in the
Bella Crafts 2017 Volume 5 Issue 1

remaining space with mini popsicle sticks,
trimming excess length with scissors or tree
trimming shears. Then, sand any rough
edges. Finish with 56 mini wooden buttons
around the top edge. Accent with wooden
hearts, carved medallions and wheels.
6. Place the butterfly wings and body on
newspaper in a well-ventilated area (or
outside), spray a black base coat and then,
let dry. Top coat with layers of taupe,
copper and antique gold spray paint, using
small random bursts of paint until you are
pleased with the result. NOTE: If placing
outside, hang in a protected area, away from
the weather.
7. To assemble, place the butterfly body in
center of butterfly wings, marking on either
side of the body at the top and bottom of the
wings. Create four holes with paper piercer
or awl. Cut two 24” lengths of wire, thread
one wire through the set of holes at the top
looping the wire across the butterfly body,
twist tightly at the back of the wings, then
create a 2” loop, twist wire again and then
trim excess. Repeat with the second wire
and bottom set of holes. Trim any excess
wire.
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By Rose Powell for Clearsnap

There’s something whimsical about blowing a
dandelion and making a wish. Create your own
distressed Dandelion Pallet Art and wish to your
heart’s content.

Materials:
 ColorBox Crafter's® Inkpads by Ann Butler:
Ocean Breeze, Aquamarine
 Crafter's Full Size Inkpads: Spiced Plum,
Snow, Night
 Paint Pen, white
 Walnut Hollow Rustic Heart

5. Use an Art Dauber to create random dots in
Ocean Breeze and Spiced Plum, randomly
over the heart. Smudge with a finger to
blend and dull out the color a bit.
6. Lastly, add details using a white paint pen.
7. Allow surface to dry. Then, heat set with a
dry iron or a heat gun for permanence.

Tools:
 Paintbrush
 ColorBox® Blending Kit
Instructions:
1. Press the blending tool firmly into the
Aquamarine ink and begin adding color
around the edges and top of the heart.
2. Reapply ink, as needed. Apply less
pressure as you draw the blending tool into
the center of the heart. Layer the same
color on top to create more intense areas of
color around the center focal point.
3. Add snow ink to an Art Dauber and press
firmly onto the surface in a circular pattern.
Layer the ink to create more intense color.
4. Next, with a flat tip paintbrush and Night ink,
draw lines to create dandelion stems.
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By Lisa Rojas

I have been a paper artist for many years now and one
of the things I love to do is add unexpected products to
my projects. For this album, I added balsa wood to
create the door and window. It’s very easy to cut with
an exacto knife and it gives the album a unique look. I
hope you give this a try!
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Materials:
 Chipboard album, 6” x 6”
 Cardstock: ivory, variety
 Patterned paper, variety
 Mini flowers
 Mini ivy
 Lace
 Binder rings
 Re-inker, brown
 Inkpad, black
 Stickers, floral
 Balsa wood
 Beacon Adhesives Zip Dry
Tools:
 Glue gun
 Rubber stamps, words
 Paintbrush
 Paper trimmer
 Exacto knife
 Paper bowl
Instructions:
1. Cover the chipboard album with patterned
papers with Zip Dry.
2. For the door, cut a ¼” thick piece of balsa
wood 2 ¼” x 3 ¼”. Next, cut two pieces 2 ¼”
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x ¼”.
3. For the window, cut two pieces ¼” x 3 ¼”, cut
two pieces 1/8” x ½”, two pieces 1 ½” x ¼”,
and one piece 1/8” x 2 ¾”.
4. In a bowl, add a small amount of water and
the brown ink to create a wash. Paint all the
pieces of the balsa wood. Let dry.
5. Assemble the door and window with the glue
gun. See the photo for placement.
6. Attach a small piece of lace to the backside of
the window. Then, glue the door and window
to the front of the album. Add the ivy and
flowers to the front with hot glue. See photo
for placement.
7. In black ink, stamp the word sentiment onto a
piece of ivory cardstock. Tear around the
edges and glue it to the front of the album.
8. For the inside pages, cut various cardstock
and patterned papers 5” x 5”. Stamp word
sentiments on ivory cardstock, tear the edges
and attach them to the pages. Add floral
stickers randomly on the pages. On some of
the pages, add different frames for photos.
9. Once the inside pages are laid out as desired,
put all of them together with the front and
back album covers using binder rings.
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By Sandy McTier
for Dynasty Brushes
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Welcome Spring! Flowers blooming, birds
chirping and butterflies fluttering around are
truly inspirational. Create this sweet and
colorful piece, reminding you to inspire and be
inspired. This piece was painted using the best
brushes around. Dynasty brushes make the
perfect brush for any medium and surface.
Materials:
 Plaque
 Butterflies, wood
 Inspire, wood
 DecoArt Americana Paints: Spa Blue,
Desert Turquoise, Titanium White, Purple
Pizzazz, Purple Rain, Evergreen, Pistachio
Mint
 DecoArt Multi-Purpose Sealer
 DecoArt Soft-Touch Varnish
 Transfer paper
 E6000 Glue
 Pattern
Tools:
 Dynasty Brushes: Black Gold (206S) #16,
Black Gold (206S) #8, Black Gold (206R) #2
 Mezzaluna, Medium
 Stencil,1/2”
 Sandy McTier M2 Stencil, Polka Dots
 Identi-Pen
 Pen
Instructions:
1. Prepare the plaque surface with MultiPurpose Sealer. Let dry.
2. Load #16 with Spa Blue, Desert Turquoise
and White and then paint surface using
crisscross strokes. Let dry.
3. Transfer the pattern onto the plaque using
transfer paper and a pen.
4. Stencil polka dots randomly onto the plaque
in White.
5. Paint the outer edge of the petals with
Purple Pizzazz. Paint White daisy stroke in
the center of each petal. Then, add a
smaller daisy stroke in the center of the
White in Desert Turquoise.
6. Add a White dot at the base of each daisy
stroke with a #2 brush. Add dots down one
side of each petal by dipping the end into the
paint, adding one dot on the petal and then,
continuing without reloading. As you
continue to paint, the dots will get smaller in
size.
Bella Crafts 2017 Volume 5 Issue 1

7. Next, dip the end of the #2 brush into Purple
Rain and paint dots at the top of each petal.
Then, add a smaller dot of white on top.
8. Load the #8 brush with Evergreen and paint
the stem, scrolls and center of the flower.
9. Load the Mezzaluna with Pistachio Mint and
dry brush on the top of the scrolls and on the
left of the stem.
10. Load the #2 brush with Purple Rain and
paint a small stroke on the stems and
scrolls. Repeat with a stroke of Desert
Turquoise and White to highlight.
11. Load the stencil brush with Pistachio Mint
and brush over stencil on the center of the
flower.
12. Let everything dry and then outline all of the
design with an Identi-Pen.
13. Paint the word in White. Let dry. Load the
Mezzaluna with Purple Rain and dry brush
the bottom half of the word. Wipe the brush
off, load it with White and dry brush the top
half. Load the stencil brush with White and
stencil polka dots on the top “white” part of
the word.
14. Butterflies: Load a damp #8 brush with
Purple Rain and paint butterflies. Let dry.
Draw lines on the butterflies using the fine
tip of the Identi-Pen. Load the #2 brush with
Evergreen and paint the body. Highlight with
a small stroke of Pistachio Mint in the center
of the body. Rinse the brush, load with
White and paint small daisy strokes on the
wings. Dip the tip of the brush into Desert
Turquoise and paint dots on wings. Once
glued in place, draw antennas using the
Identi-Pen.
15. Load the #2 brush with White and paint
small strokes around the scrolled top of the
surface.
16. Load the stencil brush with White and dry
brush around the edges of the surface.
17. Varnish the pieces with Soft-Touch Varnish.
Let dry.
18. Attach the butterflies and Inspire.

Designer Tips:
 When dry brushing, load the brush with
paint, wipe most of it off onto a paper towel
and then, dry brush an area. Repeat, as
needed, to build color.
 Use promo code sandymc for an additional
discount on your brushes.
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By Suzanne Cannon for Quietfire Design

“Believe” is such a wonderful word and can be used in
so many ways! Here I’ve used it as encouragement by
pairing it with a comforting quotation. It’s combined
with butterflies on a wooden canvas so it can be hung
anywhere or it can sit on a table top or mantle as a
constant reminder. Keep it for yourself or give it to
someone who might need a little boost. You know
they’ll love it because you made it!
Materials:
 Walnut Hollow 6 x 6” Basswood Canvas
 Plaid FolkArt Home Décor Chalk Paint,
Cascade
 Plaid FolkArt Acrylic Paint, Purple
 Plaid FolkArt Multi-Surface Satin Acrylic
Paint, Sky Mist
 Imagine Crafts VersaMagic Stamp Ink:
Purple Hydrangea, Aspen Mist, Aegean
Blue, Sage
 Core’dinations Cardstock, Valiant Violet
 Glue Dots, Micro
 Removable tape
Tools:
 Quietfire Design – Always Believe stamp
 Elizabeth Craft Designs A Way With
Words, Believe die
 Elizabeth Craft Designs A Way With
Stencils, Butterflies & Stars Spray
 Foam brush
 Sponges
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Instructions:
1. Apply chalk paint to the canvas. Let dry.
One coat should be sufficient.
2. Stamp the sentiment in Purple
Hydrangea ink. Let dry.
3. Tape the stencil in place (positioned as
shown in the photo) with removable tape
and lightly sponge Purple and Sky Mist
paint through the butterflies. Gently peel
away the stencil and let dry.
4. Replace the stencil and sponge Distress
ink through the butterflies until the color
suits your taste. Remove the stencil and
let dry. Place the stencil along the edges
of the panel and sponge ink. Without the
light paint underneath, the effect will be
subtler. Let dry before stenciling the next
side. Repeat until all four sides are
colored.
5. Sponge Aegean Blue ink lightly around
the edges of the panel front.
6. Die cut Believe and adhere to canvas, as
shown.
7. Pat yourself on the back!
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By Donna Salazar for Donna Salazar Designs

I’ve been doing a lot of mono printing on the Gel Press plates.
I usually like to make my mono prints on the 12” x 14” plate
and trim them down to fit my projects so I end up with lots of
extra strips that I keep on hand for use on projects like this.
The mono print strips make a great bohemian looking
background for the die cut flowers on this card. The
combination of paint, glitter, ink, flowers and twine make this a
very typical Girlie Grunge style project.
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Materials:
 Donna Salazar Designs® with Scrapbook
Adhesives by 3L®: Girlie Grunge Art
Medium, Girlie Grunge Twine
 Donna Salazar Designs® Colorbox Mix’d
Media Inx, Berries
 Donna Salazar Designs® Colorbox Twinkle
Dust Glitter, Mixed Berries
 Cardstock, ivory
 Patterned paper
 Flower stamens
 Permanent marker
Tools:
 Donna Salazar Designs® with
Spellbinders®: Jumbo Rose Steel Rule Die,
Big Blossom Die, Journal Words stamp set
 Spellbinders Tool-in-One
 Foam pad
 Scrapbook Adhesives by 3L, E-Z Runner
Ultra, Crafty Power Tape, Dodz XL, Dodz 3D
 Gel Press Reusable Gel Printing Plates

Instructions:
1. Cut 8.5” x 11” cardstock in half, score one
and fold in half for the card base.
2. Cut several strips of paper to fit across the
center of the card (monoprints made on the
Gel Press are used on the sample)
3. Adhere the strips together and then, attach
to the front of the card. Trim off the ends.
4. Die cut 2 layers of ivory card stock using the
Jumbo Rose die.
5. Die cut 2 layers of patterned card stock
using the Big Blossom die.
6. Die cut leaves from mono printed paper.
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7. Cup the petals of each flower die cut with
the Tool-in-One or a dry embossing stylus
and foam pad.
8. Adhere the Jumbo Rose die cut flowers with
the petals off set.
9. Feed flower stamens through the center hole
in the Jumbo Rose, trim the ends and use a
Dodz XL to adhere the stamens to the back
of the flower.
10. Wrap the Big Blossom die cut around flower
stamens and use a Dodz XL on the tab to
secure the flower.
11. Repeat for the 2nd flower.
12. Ink the sides and top of the Big Blossoms as
well as the tips of the Jumbo Rose with ink.
13. Paint the inside of the petals and the center
of the Jumbo Rose as well as the center of
the Big Blossoms with the art medium and
then, sprinkle with the glitter.
14. Adhere the flowers and 3 leaves to the card.
15. Use a permanent marker to add squiggly
lines to the edges of the mono printed strips
and leaves.
16. Fold several flower stamens in half and wrap
the ends with tape. Then, tuck them into
one of the flower clusters. Repeat 2 more
times.
17. Wrap twine around 3 fingers 8 times and
then, wrap the end with tape. Repeat a 2nd
time and tuck the ends (with the adhesive)
into the flower cluster.
18. Stamp the “Journal Words” stamps onto
ivory card stock. Cut the words into strips.
19. Ink the edges of the word strips and card
with ink and then, attach them to the front of
the card.
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By Lorine Mason

An outfit is not considered complete without the right footwear. What says
I am a maker and I am proud of it better than a pair of hand-painted
Espadrilles that perfectly complement your chosen outfit? Show off your
personal style while wearing your artwork.
Materials:
 Dritz® Espadrille soles
 100% Cotton duck fabric, natural color, 1/3
yard
 Cotton blend lining fabric of your choice, 1/3
yard
 Pentel Arts® gel roller fabric pen, black
 Tulip® Fabric spray paint, assorted colors
 Espadrille creative yarn
 Espadrille iron-on stabilizer
 Thread to match cotton duck fabric
 Copy paper, multiple sheets
Tools:
 Elastic Bands, (4)
 Fabric marking pen
 Scissors
 Pencil
 Fabric transfer paper
 Dritz® Espadrille large eyed needle
 Dritz® Espadrille yarn wax
 Dritz® Espadrille point turner
 Dritz® Espadrille glass head pins
 Measuring tape or ruler
 Paintbrushes, assorted sizes
 Paint palette
 Paper towel
 Water bucket
 Iron
 Sewing machine
Instructions:
1. Select the correct size pattern from the
espadrille sole package and cut the pattern
pieces apart, cutting along the appropriate
size lines identified on the pattern pieces.
Note: Tips have been provided to assure a
correct fit. Read the directions provided with
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the packaging before starting the project.
2. Place the pattern pieces on top of the cotton
duck fabric, referring to the directions
regarding grain lines. Trace around each of
the pattern pieces loosely, drawing the
tracing line a minimum of ½ inch out from
the pattern line.
Note: The cotton
duck fabric will shrink when paint and water
are applied. The exact pattern pieces will be
cut out later in the project. Do not cut out
pattern pieces at this time.
3. Fold the fabric back and forth, creating 1
inch fan-like folds. Wrap elastic bands
around the fabric to secure.
4. Using the color of Tulip® fabric spray paint
of your choice, spray the fabric. Cut the
elastics and open the fabric folds. Let dry
then press flat. Note: If you would like more
color, simply repeat the process.
5. Open the Espadrille creative yarn and
spread yarn on top of multiple layers of the
paper towel. Using the color of Tulip® fabric
spray paint of your choice, spray the yarn.
Let dry.
6. Choose a desired line work pattern using
clip art on your computer, coloring books or
by tracing an image using a stencil.
7. If using a printed pattern, place the transfer
paper between the pattern and the right side
of the cotton duck fabric and trace over the
pattern lines using the pencil. Add images
as desired. If using a stencil or free-hand
drawing your own pattern, do so directly
onto the right side of the cotton duck fabric.
8. Use the gel roller pen to trace over the
pencil lines. Create interest in the line work
design by varying the thickness of the lines
and filling in the designs with a variety of
©2017 Bella Crafts™
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repetitive patterns. Follow the
manufacturer’s directions and heat set the
ink before moving to the next step.
9. Pour fabric spray paints into the wells of the
paint palette. Dip your brush into clean
water and then remove the excess water by
touching the brush to a piece of clean paper
towel. The paper towel will absorb the
water. Dip the end of the brush into the
chosen color of paint. Using a scrap of
cotton duck fabric practice painting color
onto the fabric. Play with the colors,
deciding which colors you like together.
Adjust the amount of water that is left on the
brush for a watercolor look. Once you feel
confident, you are ready to start adding color
to your line work design.
10. Lightly touch the tip of the paintbrush to the
cotton duck fabric just inside the line work
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and let the paint flow towards the outside
line. If the color flows over the line work and
you are not happy with the look, let the paint
dry and then extend the line work over the
excess paint. You might just be surprised
and actually like the look. Be kind to
yourself.
11. Let the paint dry a minimum of four hours.
12. Press the painted fabric flat.
13. Lay the pattern pieces onto the painted
fabric and cut out all of the pattern pieces,
cutting along the appropriate size lines.
14. Refer to the Espadrille sole instructions
provided within the packaging to complete
your Hand Painted Espadrilles.
15. You may want to protect your Hand Painted
Espadrilles by spraying them with a
protective coating of your choice.
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By Retro Recreations

We didn’t pioneer the idea of an I-Cord
knitter. In fact, we weren’t around when
the machine was introduced in 1947.
However, we did resurrect the idea with
the purpose of perfecting its design and
reintroducing a more user-friendly
version. Handcrafted from Northern
Michigan Maple, our I-Cord EZ Knitter is
the perfect way to heighten anyone’s
knitting or weaving game.
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I-Cord EZ Knitter Threading
Instructions
1. Run the yarn through the circle on the mast
so it comes out on the side where the front
loop is. (figure 1)
2. Run the yarn through the hole in the yarn
guide. (figure 2)
3. Feed the yarn down through the center hole
in the needle arbor. (figure 3)
4. Tie a loop in the yarn that has come out the
bottom of the needle arbor. (figure 4)
5. Hold the yarn just above the loop and hang
the weight on the loop. Do not release the
yarn until steps 7 and 8 are completed.
6. Grasp the yarn just before it goes into the
circle on the yarn mast.
7. Hold the yarn firmly enough that it does not
slide through your fingers when you release
the weight.
8. Gently lower the weight until there is tension
on the yarn.
9. Using your right hand, slowly turn the crank
clockwise.
10. Skip every other needle as the cylinder
rotates until you have made one complete
revolution. Using a small crochet needle to
help you guide the yarn over the needles that
you are skipping is helpful; although you can
do it with your fingers. (figure 5)
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11. The yarn should hook onto all the needles
after the first revolution. It will look similar to
a spider’s web as the I-cord begins to form.
(figure 6)
CAUTION:

As you knit, watch your weight
and yarn. Your weight must never touch the
floor, doing so will cause the needles to drop
stitches and the yarn will ride up on the needles.
You will need to move your weight up the I-Cord
strand as you continue to make I-cord. Your
yarn must flow freely from the ball. If you
feel any resistance as you crank, stop
immediately and discover the problem.
To remove the I-cord, cut the yarn at the yarn
guide. Remove the weight and gently pull the ICord with one hand while turning the crank with
the other until the yarn is through the machine
and the I-Cord is released.
For more information on our
company, the crafts you can make with Icord, or to purchase your I-Cord EZ Knitter
go to: www.retrorecreate.com
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By Theresa Cifali

I don’t know about you, but the holidays mean having
lots of empty wine bottles. Instead of recycling them,
upcycle them instead! This project is so much fun to
make and will find their home on my fireplace mantle.
They’d look great on a coffee table, too!

Materials:
 Wine bottles (3)
 Apple Barrel Multi-Surface Paint: Princess
Purple, Acapulco, Primary Blue, White
 White Gesso
 Burlap ribbon, 2 ½”
 Twine
 Metal letters
 Burlap flowers and butterflies
 Beacon Adhesives Power Tac
 Rubbing alcohol
Tools:
 Glue gun
 Sand paper, 220 grit
 Flat brush
 Small container with lid
 Scissors
 Cotton balls
 Paper towels
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Instructions:
1. Clean the outside of the bottles with rubbing
alcohol.
2. Mix the Primary Blue and White paint
together in a sealable container to lighten up
the blue.
3. Paint each bottle with one color of paint. Let
dry and then, sand.
4. Working in sections, add gesso over the
colored paint and then, wipe off immediately.
Repeat until the entire bottle has a white
wash effect.
5. Securing with hot glue as you work, wrap the
twine around the bottleneck, starting at the
top and working down to the base of the
neck.
6. Next, wrap a piece of burlap ribbon around
the bottom and secure with hot glue in the
back.
7. Randomly wrap twine over the burlap ribbon
in a criss-cross pattern, securing with small
dabs of hot glue.
8. Attach a metal letter, burlap flower and burlap
butterfly to the front of the bottle with Power
Tac. Let dry completely.
9. Repeat steps 4 through 8 for each bottle.
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By Ann Butler

Welcome Spring with this framed wall art. Simply made by
stamping out SPRING onto layered coordinating cardstock
squares and arranging onto mat board.
Materials:
 Ann Butler’s Crafter’s Ink by Clearsnap,
Blueberry
 Ann Butler’s 2” Flourish Alphabet Stamp Set
 Colorbox Embossing Powder, Clear
 Decorative cardstock, 2 ½” x 2 ½” (12), 2 ¾”
x 2 ¾” (12), 3” x 3” (12)
 Cardstock, 3 ¼” x 3 ¼” (12)
 Frame, 12” x 14”
 Mat board, white, 12” x 14”
 Tape runner

Instructions:
1. Stamp the word SPRING onto 6 pieces of the
2 ½” x 2 ½” cardstock. Then, apply
embossing powder and heat set.
2. Layer the cardstock squares and glue
together starting with the smallest to the
largest.
3. Attach the squares onto the mat board, as
shown in the photo.
4. Place the mat board into the frame.

Tools:
 Heat gun
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By Theresa Cifali

The inspiration for this box came from a stencil I saw
that reminded me of an old couch we had when I was
a child. Adding a little bling and a monogram dresses
it up and ads a more modern touch. This box will
make a wonderful addition to any woman’s vanity.
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Materials:
 Folk Art® Handmade Charlotte, Paisley
Delight stencil
 Folk Art® Home Décor, Chalk: Seaside Villa,
White Adirondack
 Folk Art® Home Décor, Wood Tint, White
 Wood box
 Wood letter
 Glitter, ultra fine
 Paper towel
Tools:
 Foam brush
 Flat brush, ½”
 Stencil brush
 Blue Painter’s Tape
 Sand paper
 Glue gun
 Tin pan, large
Instructions:
1. Lightly sand the box and the letter. Wipe off
any dust with a damp paper towel.
2. Remove the lid from the box. Using a foam
brush, stain both parts. One coat should do,
but add a second if desired. Let dry
completely.
3. Paint the letter white. Let dry completely and
then, sand the edges and top to distress.
4. Place the stencil on the bottom front of the
box and secure with tape. Then, stencil on
the Seaside Villa paint. Remove the stencil,
sprinkle on glitter over a tin and tap off the
excess. Continue this process around the
entire box bottom. Let dry.
5. Next, secure the stencil to the top of the box
and add paint. Remove the stencil, sprinkle
on glitter over a tin and tap off the excess.
Depending on the size of your box, you may
need to move the stencil over and continue
the pattern. Let dry.
6. Attach the stencil to the top of the letter and
add paint. Remove the stencil, sprinkle on
glitter over a tin and tap off the excess. Let
dry.
7. Paint the sides of the letter with Seaside Villa.
8. Paint around the lip of both the top and
bottom of the box with Seaside Villa.
9. Glue the letter to the top, center of the box.
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By Karen Jiles for Xyron

Handcrafted gifts are the perfect way to let someone know you are
thinking of them. What I love most about handcrafted items is you can
tailor them to any color, theme, event or person. This project is an
inspirational keepsake to encourage creative expression. I added some
fun texture and colorful elements to inspire my own creativity!
Materials:
 Xyron® Adhesive Dots
 Xyron® Mega Runner
 Watercolor paper, 6” x 6”
 Wooden frame 7 ¾” x 7 ¾”
 VersaMark™ ink
 Ranger Distress® Inks/Stains
 Embossing powder, clear
 Ribbon
 Gesso
 Resin frame
 Typo bulbs
 Flowers
 Charms
Tools:
 Xyron® Creative Station™
 Foam brush
 Script stamp
 Water
 Heat tool
 Craft sheet
 Glue gun

8. Create distressed bows with the ribbon.
9. Apply white gesso to the wooden frame. Let
dry.
10. Apply Ranger Distress stain to the frame with
finger. Set aside to dry.
11. Run two inked watercolor papers through the
Creative Station to apply adhesive.
12. Remove film and layer the watercolor papers
together using a step down effect on the
wooden frame.
13. Adhere the resin frame onto the wooden
frame with hot glue.
14. Using the Mega Runner, adhere flowers,
leaves and distressed ribbon bows to the
frame.
15. Attach CREATE and inspire typo bulbs to the
frame with the Mega Runner.
16. Add the metal charm, hang on the wall and
enjoy!

Instructions:
1. Ink the script stamp with VersaMark ink and
stamp onto watercolor paper.
2. Apply clear embossing powder to the
stamped image. Shake off excess.
3. Use the heat tool to emboss the stamped
image on the paper.
4. Apply Ranger Distress inks to the craft sheet
and spray water into the ink.
5. Lay embossed watercolor papers onto the
inked craft sheet. Stand paper up to allow
the ink to drip and set aside to dry.
6. Repeat step 4 to create additional
backgrounds for layering.
7. Ink ribbon with the remaining ink on the craft
sheet and set aside to dry.
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Name of Project: Save Water...Drink Wine
Type of Project: 3D Shadowbox Wine Frame
Technique Used: Glass etching
Products Used:
etchall etching crème
etchmask and transferpaper
Pik tool
Squeegee

Project by: Julie McGuffee

Name of Project: Beaded Double Necklace
Type of Project: Jewelry
Technique Used: None
Products Used:
Jesse James Beads
Beadalon

Project by: Maria Soto
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Name of Project: Mixed Media Mermaid
Type of Project: Mixed Media

Technique Used: Painting
Products Used:
So You Say You Can’t Draw Stencil
Gelatos
Deco Art Mixed Media Fluids
Molotow Paint Pens

Project by: Rita Barakat

Name of Project: Beautiful Sculpted Clay Dress
on Wood Canvas
Type of Project: Clay
Technique: Sculpting
Products Used:
Makin’s Clay
Deco Art Media Paint

Project by: Donna Budzynski
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Name of Project: Live Creatively Journal
Type of project: Journal
Technique Used: Mixed Media
Products Used:
Deco Art paints
Stampendous stamps
Zip Dry
Chipboard
Chicken wire

Project by: Marjolaine Walker

Name of Project: Combing Ink & Paint in Your
Art Journal
Type of Project: Tutorial
Technique: Inking and Paint Techniques
Products Used:
Gel Printing Plate
Tim Holtz Fariytale Frenzy stamp set
Paint
Ink

96

Bella Crafts 2017 Volume 5 Issue 1

Project by: Marjie Kemper
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Name of Project: Felt Bear Pin
Type of Project: Jewelry
Technique Used: None
Products Used:
Kunin Classicfelt
Embroidery floss
Pin back

Project by: Laura Bray

Name of Project: How I Used Resin with a Gel
Plate
Type of Project: Painting
Technique Used: Creating a resin texture piece,
painting it and then, using a Gel Press plate to
leif off the paint.
Products Used:
Gel Press
Resin
Paint

Project by: Tanya Ruffin
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Name of Project: Fun with Sizzix Gift Bags
Type of project: Paper
Technique Used: Die Cutting
Products Used:
Sizzix Big Shot
Sizzix Bigz Die Frog
Cardstock
Spring Themed gift bags
Paper flowers
Googly eyes

Project by: Rena Gonzalez

Name of Project: Making a Flower Coloring
Page Card with Cricut
Type of Project: Paper
Technique Used: Electronic Die Cutting Maching
and Coloring
Products Used:
Cricut Explore
Floral Coloring Card Make-it-now project
Cricut Design Space Software
Flower cut outs and hear accessories designed
by Jen Goode
Project by: Jen Goode
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Name of Project: Shabby Chic Lamp
Type of Project: Home Décor
Technique Used: Etching
Products Used:
etchall dip n’ etch
Quart jar
Chalk paints
Trims

Project by: Marilyn Gossett

Name of Project: Easy DIY Photography
Backdrops
Type of Project: How-to
Technique Used: None
Products Used:
Craft board
Wood glue
Stain or paint

Project by: Cheryl Boglioli
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